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ABSTRACT 

The endangered Bornean elephants (Elephas maximus borneensis) are endemic to the island of 

Borneo and their survival is being threatened by palm oil production, poaching and human-

elephant conflicts. In Central Sabah (Malaysia), the conversion of forests into commercial 

plantations has led to habitat fragmentation and human-elephant conflicts. The present pilot 

study aimed to assess the suitability of a protected forest reserve in Central Sabah (INIKEA 

Forest Rehabilitation project site) for elephants, assess elephant distribution at the site and 

document the presence of other terrestrial mammals. This was done using a combination of 

wildlife surveys. The potential role of this forest reserve in wildlife management and 

conservation is as well discussed.  

This study confirms the presence of the Bornean elephant and other endangered mammals like 

the sun bear (Helarctos malayanus) at the INIKEA site. Results indicate that single bulls, 

bachelor groups, small family units and herds use this site, which has 8,356ha (42% of the total 

extension) of suitable elephant habitat. This preliminary assessment suggests that the elephants 

travel through the main road as well as roam and feed in forested areas and old roads that are 

mainly flat, relatively easy to access from the main road and nearby rivers. Results also indicate 

that this site can play an important role as a corridor for the elephants to connect with other 

forest reserves in Central Sabah and as a refuge to avoid areas highly disturbed by humans. The 

findings suggest that the rehabilitation of degraded lands and protection of forests can play a 

key role on the conservation of endangered species and provide a basis to conduct further in-

depth surveys and long-term monitoring in the area. Further research is needed to better 

understand elephant movements in this changing landscape and systematically assess the status 

of mammalian fauna in the reforested areas. 
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1. INTRODUCTION 

  

Borneo is the third largest island in the world and one of the world's biodiversity hotspots 

(Mittermeier et al. 2011). Its tropical forests are crucial to humans because they provide a wide 

range of ecosystem services such as clean air, water, timber and food and are also home to a 

vast variety of species, some of which are endemic of the island. Unfortunately, over half of 

the forests of Borneo have disappeared, a third of them during the last three decades, mainly 

due to the conversion of natural forests into commercial oil palm and timber plantations 

(Wulffraat et al. 2017). The loss of natural ecosystems in Borneo represents a threat to, both, 

humans' future development and the island's biodiversity.  

 

One of the animals threatened due to habitat loss and fragmentation in Borneo is the Bornean 

elephant (aka pygmy elephant) (Elephas maximus borneensis), which is only found in north-

east Borneo and almost exclusively in the Malaysian state of Sabah (Goossens et al. 2016). 

Practically nothing was known about Bornean elephants until WWF-Malaysia initiated a 

project in the year 2000 to study the elephants' home-ranges, habitat preferences and movement 

patterns as well as the differences between elephant groups living in different parts of Sabah 

(Alfred et al. 2007). Thanks to the work done by direct field observations as well as a GPS 

tracking project started in 2005, it was determined that the elephants' movement and home 

range are influenced by the size of the natural forest habitat, the availability of water sources 

and, specially, by human activity and forest disturbance. It was also found that the studied 

elephants' preferred habitat was the lowland forest with flat ground or gentle slopes and an 

altitude below 300-400m (Alfred et al. 2007, Alfred et al. 2012). It is estimated that there are 

around 2,040 elephants in Sabah (Alfred et al. 2010) and over 90% of the wild elephant 

population concentrates in four Managed Elephant Ranges: Lower Kinabatangan (400 km2), 

North Kinabatangan (1,400 km2), Tabin (1,200 km2), and Central Sabah (7,900 km2) (Sabah 

Wildlife Department 2011). The main threats to Bornean elephants in Sabah in addition to 

habitat fragmentation and loss are poaching, low genetic diversity and human-elephant 

conflicts (HECs) (Sabah Wildlife Department 2011).  

 

Not much is known about the biology of Bornean elephants, their ecological and economic 

impacts on the landscape or to which extent human activities are affecting them. During the 

last decades, their natural habitats have decreased because part of them have been converted 

into commercial plantations for timber and oil palm as well as human settlements (Sabah 

Wildlife Department 2011). In many parts of Sabah, elephant groups now live in fragmented 

landscapes with forest patches surrounded by plantations and some of them in proximity of 

villages. The loss of connectivity between the four Managed Elephant Ranges identified in 

Sabah has increased the isolation between elephant groups, which can severely affect their 

genetic structure due to a restriction in the gene flow. The loss of genetic diversity due to the 

effects of genetic drift and inbreeding can have negative consequences for the elephant 

populations and potentially lead them to extinction (Goossens et al. 2016). In addition, the 

elephants often travel through the plantations to be able to get from one part of their home 

range to another and sometimes feed from the plantations' crops as well as from family 

agricultural crops around villages. This proximity to the plantations and human settlements can 

increase the risk of HECs and, thus, increase the chances of both humans and elephants being 

injured or killed (Alfred et al 2011, Goossens et al. 2016). Additional research on elephant 

movements and home ranges was initiated in 2013 with the collaring of three females by Sabah 

Wildlife Department, Danau Girang Field Center and WWF-Malaysia. This was done in order 

to better understand the ranging behaviour of the elephants inhabiting the Kalabakan and 

Gunung Rara regions, which are inside the UNDP (United Nations Development Programme) 
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project area in Central Sabah. In that region, the landscape is rapidly changing, and 

management measures are needed in order to find better land-use practices and mitigate the 

human-elephant conflict (Othman et al. 2013). In fact, 14 elephants were found dead in 2013, 

presumably of being poisoned, in Gunung Rara Forest Reserve (National Geographic News 

2013). Other recent serious conflicts between humans and elephants in the region are: attack to 

workers at the plantation of Brumas (near Kalabakan) (Borneo Today 2016a), death of a worker 

at the timber plantation of Dumpas (near Kalabakan) by an elephant bull who was consequently 

culled (Borneo Today 2016b, WWF 2016), death of a male elephant also at Dumpas plantation 

area (Borneo Today 2017a) and death of a male elephant by gunshot at Cenderamata plantation 

(near Kalabakan) (Borneo today 2017b). The above stresses the importance of finding solutions 

in the Central Forest of Sabah, which is the Managed Elephant Range with the highest number 

of elephants (around 1,132 individuals) (Alfred et al. 2010). This is needed, both, for the 

conservation of the endangered Borneo elephants and for people’s safety and wellbeing. 

Indeed, habitat degradation and loss are not only a threat to the conservation of biodiversity 

but also trigger human-wildlife conflicts. 

 

During the past years, restoration projects have been initiated in Sabah to restore degraded/lost 

rainforest as well as to create corridors for wildlife. One of the examples is the Innoprise-IKEA 

Forest Rehabilitation project (INIKEA project), which started in 1998 and is located in the 

Sungai Tiagau Forest reserve inside the UNDP area. This project is a collaboration between 

the Sow-A-Seed Foundation of the Swedish company IKEA, the State Government Statutory 

Body Yayasan Sabah Group, and the Swedish University of Agricultural Sciences, which has 

been providing technical and research support. The main objective of this project is to 

rehabilitate a secondary rainforest that was degraded by selective logging and fire. So far, about 

13,000ha have been reforested by planting indigenous tree species, mainly dipterocarps but 

also fruit trees, which are expected to attract animals that will in turn act as vectors for seed 

dispersal (Alloysius et al. 2010). In fact, one of the expected outcomes of the INIKEA project 

is the return of wildlife to the reforested areas. During the last months, several endangered 

species, such as orang-utans (Pongo pygmaeus), hornbills (sub family Bucerotinae), clouded 

leopards (Neofelis diardi) and Bornean elephants, have been found to use the INIKEA project 

site (Sow-a-seed 2017). However, no systematic surveys have been carried out yet to assess 

the status of fauna of this site as well as its potential role in wildlife management and 

conservation. To assess the success of a rehabilitation project, in addition to vegetation’s 

recovery and diversity, there is the need to evaluate the recovery of other trophic levels and 

ecosystem processes (Ruiz-Jaén & Aide 2005). Unfortunately, since the status of biodiversity 

was not assessed before the start of the INIKEA project it may not be possible to quantify the 

recovery of fauna at the reforested areas (UNDP 2012).  

 

Nevertheless, it is important to assess the current status of biodiversity at the Sungai Tiagau 

Forest reserve (INIKEA site) because it is strategically located between three large 

conservation areas in Central Sabah (figure 1) and can play an important part in the 

conservation of biodiversity. As a matter of fact, in 2013 the Sabah Forestry Department 

increased the status of protection of this reserve (previously part of the Kalabakan commercial 

forest reserve) and three other forest reserves in Central Sabah that were considered to have 

high conservation value (Forests Enactment 1/2013). These reserves were reclassified from 

Class II (commercial use) to Class I (totally protected) in order to protect their biodiversity, 

serve as buffer zones for the Maliau Basin Conservation Area as well as to create a wildlife 

corridor to link the Maliau Basin, Imbak Canyon and Danum Valley conservation areas. In 

addition, this site might also potentially act as a refuge for wildlife to avoid degraded lands and 

areas with high human disturbance, which are planned to increase in the future with the 
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conversion of surrounding lands into oil palm plantations (Othman et al. 2013). The INIKEA 

site might thus also be key to reducing human-wildlife conflicts in the region, especially HECs. 

Knowledge on how endangered species such as the Bornean elephant are using this reforested 

forest reserve will give insight into the role that forest rehabilitation and protection can play on 

the conservation of endangered species and the restoration of ecosystems and ecosystem 

services.  

 

 
Figure 1: Map of the totally protected forest lands in Sabah as of December 2016 (from Sabah 

Forestry Department). The location of the INIKEA project site is marked with a pink square.  

 

The main objectives of this project are:  

 

1) To identify potential suitable habitat for Bornean elephants at the INIKEA site. 

 

2) To assess the presence of medium-large terrestrial mammalian fauna in the INIKEA site. 
 
3) To document the presence of Bornean elephants at the INIKEA site and assess in a 

preliminary way their group composition and use of the site (distribution and plant 

consumption). 

 
4) To discuss the potential role of the INIKEA site in wildlife management and conservation. 
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2. METHODS 

 

2.1 Study area 

 

The fieldwork was conducted in the INIKEA Forest Rehabilitation Project area, located in the 

Tawau district, approximately 100 kilometres north-west of the city of Tawau (figure 2). The 

site consists of 18,500 ha of experimental forest within the Sungai Tiagau Forest Reserve 

(19,870ha) (approximately 4°360’N, 117°120’E) in the Yayasan Sabah Forest Management 

Area. The forest reserve is surrounded by industrial tree plantations in the north, east and west, 

and by oil palm plantations in the south. The topography of the INIKEA site consists mainly 

of hills and valleys with elevations that range between 30-700m above sea level. The climate 

is equatorial (category “Af” in the Köppen climate classification), characterised by elevated 

levels of temperature and precipitation. The average annual temperature of the area is 

approximately 27ºC and the average annual precipitation is 2,517 mm (Gustafsson 2016).  

 

The main type of vegetation of this site used to be the lowland dipterocarp forest. However, in 

1983 the site was partly affected by the wildfires that occurred in Borneo due to drought after 

El Niño-Southern Oscillation event in 1982-1983 (Nykvist 1996, Alloysius et al. 2010). In 

addition, this site underwent selective logging between 1975 and 1985 as well as after the fire 

events. The above phenomena resulted in changes in the original vegetation. Nowadays, the 

vegetation of the INIKEA site consists mainly of secondary rainforests degraded to varying 

degrees, dominated by pioneer species like Macaranga spp as well as gingers, climbers, lianas 

and ferns (Alloysius et al. 2010). 

 

Out of the total extension of this site, around 13,000 hectares have been under rehabilitation 

and are divided in blocks of 20 up to 358 ha. Based on canopy opening, terrain and status of 

vegetation regeneration of the blocks, different treatments have been applied. For those blocks 

of the site where trees are already regenerating naturally, a treatment called liberation is applied. 

This method aims to assist the natural regeneration of the vegetation by selectively removing 

undesired plant species that compete against desired tree species, such as dipterocarps. For the 

other blocks, enrichment planting of a random mixture of indigenous tree species (70 % 

Dipterocarps, 25 % Non-Dipterocarps and 5 % Fruit trees) has taken place by two methods: 

Figure 2: Map showing part of the south-east of Asia, zoomed to the Malaysian state of Sabah 

with the INIKEA site represented as a blue star (Maps from Google Maps). 
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line planting and gap-cluster planting. Whereas the former has been applied in the most 

degraded forests (31%), the latter has been implemented in about two thirds of the reforested 

area (69%) (Alloysius et al. 2010). In addition to rehabilitation methods, the INIKEA project 

site can be divided in four phases of different rehabilitation ages: phase 1 (June 1998-May 

2013), phase 2 (August 2003-July 2018), phase 3 (January 2009-December 2023) and phase 4 

(June 2015-June 2025) (figure 3). 

 

 

 

2.2 Study design 

 

To achieve the objectives of this pilot study five wildlife survey methods were used. To assess 

the location and extension of suitable elephant habitat in the INIKEA project site, a suitability 

assessment (1) was carried out. To document the presence of elephants and other mammals at 

the INIKEA site, the four following methods were used: Semi-structured interviews (2), 

Camera trapping (3), Reconnaissance-survey transects (aka Recce-survey transects or RSTs) 

(4) and Opportunistic observations (5).  

 

All the above-mentioned methods are non-invasive, which implies that there was no need to 

handle or capture animals, and are further explained in section 2.3. 

 

Design of sampling areas 

 

Ideally, sampling methods should aim to be random and ensure maximum amount of coverage 

of the sample or survey area. Nevertheless, this can be difficult when areas are either to vast 

and inaccessible, or survey period, available resources and logistics are limited. In this study, 

due to limitations in resources and logistics, the sampling sites for the camera trap survey and 

the RSTs were set up in areas of the study site where elephant activity is, a priori, more likely 

to occur based on Alfred et al. (2012). This was done in order to obtain as much information 

as possible with the available human and material resources. Locations for the camera trap 

stations and Reconnaissance-survey transects were, thus, established based on information 

Figure 3: Map of the INIKEA project area showing the four different rehabilitation phases. 



9 
 

about suitable elephant habitat (survey 1), information obtained with the interviews (survey 2), 

as well as the accessibility of the area by car and/or foot. The sampling sites of this study 

included plots of all rehabilitation phases as well as untreated areas.  

 

 

2.3 Study procedure 

 

2.3.1 Assessment of potential suitable habitats for Bornean elephants  

 

Whether a habitat is suitable for elephants in the study area may depend on factors such as: 

water availability, type of soil and minerals, type of vegetation, altitude, steepness of the terrain 

and proximity to human activity. More specifically, research indicates that Bornean elephants 

prefer to live in lowland forests with open areas to feed and secluded areas to rest, flat or gently 

sloped ground up to 300-400m of elevation and in proximity to water sources (Alfred et al. 

2007, Alfred et al. 2012). To evaluate the suitability of the INIKEA project site for elephants, 

the areas of the site with their potentially preferred habitat were mapped and calculated with 

the GIS software ArcMap. Unfortunately, no information on vegetation types and type of soil 

of the INIKEA site was available. Therefore, this assessment only considered the factors: 

steepness of the terrain, altitude and distance to main rivers. First, a map of the site with 

topographical features and main rivers was obtained by joining a shapefile of the polygon of 

the INIKEA site and the GIS data layers of elevation and main water bodies of Malaysia 

downloaded from DIVA GIS (www.gdata.org). Second, suitable habitats for elephants at the 

site were mapped by selecting areas that fulfilled three criteria based on elephant habitat 

preference. 

- Elevation: Areas with an elevation up to 400m were selected. 

- Steepness of the terrain: Although elephants can travel through slopes if necessary, they avoid 

navigating steep terrains because it represents a high energetic cost for them (Wall et al. 2006). 

Therefore, areas with an appropriate steepness for the elephants (up to 7.5 degrees) were 

selected.  

- Distance to water sources: Elephants require approximately 100-200 litres of water per day 

and their average travelling rate is 1.68km/day (Alfred et al. 2012). Based on their daily water 

needs, it is expected that elephants will not, a priori, be further than two km away from a water 

source. Therefore, a buffer of two km was created at each side of the rivers and the areas located 

inside of this buffer were selected. 

 

Finally, the total extension of the areas of the INIKEA site that can be potentially preferred by 

elephants was calculated with a tool of ArcMap called Calculate Geometry. 

 

The projection system used for this survey was GCS_WGS_1984_UTM_Zone_50N and the 

background image displayed in the suitability map was obtained from World Topographic Map 

(ArcMap). For a detailed flowchart and description of the process, see Appendix (section 

7.1.2). This assessment was carried out in February 2017. 

 

2.3.2 Semi-structured interviews 

 

To gather information regarding spatiotemporal presence, group composition and HEC 

reported in the INIKEA site and surroundings, a series of semi-structured interviews were 

carried out. Subjects of the interviews included workers of the INIKEA project as well as 

inhabitants of Luasong (the local village) and surroundings. The interviews took place as an 

http://www.gdata.org/
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informal conversation, and all relevant information regarding elephant activity was 

documented and stored in a database. Data collection for this survey took place between March 

and June 2017. A sample of the questions included in this semi-structured interview is attached 

in the Appendix (section 7.1.1).  

 

The information obtained from the interviews was represented in a map for those cases in which 

a specific location of elephant presence was provided. This allowed to obtain a preliminary 

idea of elephant presence at the INIKEA site and surroundings. To do so, the program QGIS 

2.18 Las Palmas de G.C. was used. 

 

2.3.3 Camera trapping 

 

Camera trapping is a method to study wildlife in which a number of cameras are set up at 

specific locations to capture as many images as possible of the individuals and/or species that 

inhabit or roam in the area. The sampling design of a camera trap survey (number of cameras, 

location, height, angle, etc.) can influence the results and its interpretation (O’Brien 2011, 

Ancrenaz 2013, Cole Burton et al. 2015). Therefore, this survey was designed following the 

recommendations of Ancrenaz et al. (2012) and the Instruction Manual of the cameras 

(Reconyx 2015) in order to target medium to large-sized mammal species.  

 

Data collection 

 

Sampling took place between April and June 

2017 and was divided in four sampling periods 

of different length (Period 1 – 13/14 days, 

Period 2 – 13/15 days, Period 3 – 34/35 days 

and Period 4 – 14 days), depending on whether 

it was possible to reach the sampling stations by 

car/foot at a specific moment. For every 

sampling period, six sampling stations were set 

up, which resulted in a total of 24 different 

stations for this survey. These sampling stations 

were installed in various locations where signs 

of elephant presence had been found or can 

potentially be found (i.e. suitable habitats for 

elephants) and where accessibility was possible 

by car or no more than 4km by foot. At each 

station, two cameras were installed facing each 

other with a separation distance of 

approximately 7-15m and attached to a tree 

trunk at a distance of more or less 1m above ground level (figure 4). The position of each 

station was estimated using a GPS device (Garmin Oregon, Garmin International Inc. USA). 

Sampling stations were not located facing busy roads, due to the high chance of getting multiple 

undesired pictures triggered by vehicles, waste of batteries due to increased activity of the 

cameras as well as a higher chance of the cameras being stolen. The locations of the 24 stations 

with camera traps are displayed in a map in figure 5. 

Figure 4: Photography of one of the camera 

traps installed at Station 2. 
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For this survey, Reconyx HC500 HyperFire digital camera traps (Reconyx, Holmen, 

Wisconsin, USA) were used. Each camera was programmed to ‘high’ trigger sensitivity and 

set to take three photographs when triggered, with a 1 second interval between pictures and no 

quiet period or delay between triggers. For every photograph captured, date, time and 

environmental temperature in Celsius degrees were recorded. Each camera was equipped with 

an 8GB SD digital card to store the images and was powered by twelve AA NiMH rechargeable 

batteries. Additionally, every unit had a casing that was mounted to the tree trunk and further 

protected with a python lock in order to shelter them from the rain as well as to prevent damage 

and theft. Neither lures nor baits were employed for this survey. 

 

Data analysis 

 

To catalog the composition of mammalian species within the sampling areas, the pictures of 

the animals captured by the camera traps were identified to species level based on Payne & 

Francis (2007), Ancrenaz (2013) and Phillipps & Phillipps (2016) as well as the knowledge of 

the observers. Due to difficulties in identification, muntjacs, mouse-deer and porcupines were 

only identified to genus level in the case of the two first (Muntiacus sp and Tragulus sp, 

respectively) and to family level in the case of the latter (Family Hystricidae). Photographs 

containing animals that were not able to be identified and images without wildlife were 

excluded from the analyses.  

 

In addition to an inventory of the detected wildlife, the data of the camera traps was analysed 

with descriptive count statistics. In turn, these statistics were used to calculate the Capture rate 

(CR), a relative abundance index that informs about the trapping success (Brodie and Giordano 

2011, Ancrenaz 2013), i.e. the amount of captures obtained for a specific sampling period. 

From the values of the CR, the Trapping effort (TE) was calculated. This index indicates the 

amount of sampling days needed to get a capture with the camera. CRs and TEs were calculated 

for each mammal group for the whole survey. In the case of Bornean elephants, these indices 

were as well calculated for each sampling station in which elephants were detected.  

Figure 5: Map of the INIKEA rehabilitation project site showing the steepness of the terrain 

(in colours green to red), some of the main roads (white lines) and rivers (blue lines) as well 

as the 24 stations with camera traps (black dots) and the 22 RSTs (pink lines). 
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Total number of stations: Calculated as number of stations per sampling period multiplied by number of 

sampling periods. 

Sampling effort (SE): To calculate the sampling effort of each station (i.e. number of effective camera trap 

days accumulated), the time between the installation of the cameras and their removal was calculated. 

Total sampling effort (TSE): The total sampling effort of the survey was obtained by summing the sampling 

effort of each station. 

Number of stations at which each species/group was detected 

Total number of pictures of mammals and of each species/group 

Total number of independent captures of mammals and of each species/group: To obtain the number of 

independent captures, pictures of the same species recorded at the same station were considered as a single 

camera event when the pictures were separated by less than an interval of 1hour (Tobler et al., 2008, Brodie 

and Giordano 2011). Pictures and sequences of pictures involving more than one individual of the same species 

were considered one independent camera event. 

Capture rate (CR) (number of independent captures per 100 sampling days):  

where ‘C’ is the number of independent pictures captured of a species/group. 

Trapping Effort (TE) (number of sampling days per independent capture):  

 

 

2.3.4 Reconnaissance-survey transects 

 

To complement the data of the camera traps, the presence and activity of elephants as well as 

mammal species composition of the INIKEA site were also assessed with a pilot survey that 

consisted of a series of RSTs. The Recce-survey transect is a type of wildlife survey method 

used to obtain data about animal presence and distribution by counting signs of animal presence 

along a transect. These signs can be direct or indirect; while the former imply directly spotting 

an animal, the latter imply spotting traces of animal activity such as feed marks, footprints, 

dung, claw marks and vocalisations, among others. For RSTs, research teams try to walk the 

path of least resistance, avoiding water bodies, dense vegetation and steep areas. This makes it 

quicker than methods such as line-transect based surveys, where researchers must follow a pre-

determined straight path to collect data. The RST method is considered appropriate for pilot 

surveys in areas were little is known about the resident wildlife to get general information such 

as presence/absence. It represents a way for research teams to get familiarized with new study 

sites, equipment and techniques. In addition, this approach helps to assess the potential of a 

specific area to carry out distinct types of wildlife surveys and to identify problems in logistics 

that may arise (Hedges & Lawson 2006, Ancrenaz 2013). Regarding elephants, Recce surveys 

have been proposed as a useful first step to estimate dung-pile encounter rates in places where 

there is few or no information about elephants. This information can later be used to design 

surveys (such as DNA capture-recapture dung surveys and dung-count through line-transect 

surveys) aimed to determine elephant abundance and distribution (Hedges & Lawson 2006, 

Ancrenaz 2013). 

 

 

 

 

CR = C x 100 / SE  (for each station) 

Total CR = C x 100 / TSE  (for all stations combined). 

TE = 100 / CR (for each station) 

TTE = 100 / TotalCR  (for all stations combined). 
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Data collection 

 

For the present study, the recommendations of Hedges & Lawson (2006) and Ancrenaz (2013) 

were followed to conduct the RSTs. The transects were approximately 1km long each (with a 

variation from 698m to 1,620m) and involved two observers walking at 1-2km/h depending on 

the visibility. Every sign of mammalian presence encountered within the area comprised 3m 

(5m for elephant dung) to each side of the trajectory taken by the observers was considered. 

Both direct and indirect observations were taken into account for this survey. In the case of 

elephant signs, the GPS coordinates of their location were recorded, and pictures were taken 

for each of them. In addition, the type (print, dung, feed mark, etc.) (figure 6) and condition 

(intact, altered) of the sign and estimated date of the presence of the elephant/s (e.g. with dung 

decay stages) were as well documented. In the case of feed marks, the type of plant eaten by 

the elephants was identified as accurately as possible. With regard to the rest of mammalian 

signs, only presence/absence in the transect was considered, regardless of the amount and 

location of the signs. Information regarding the rehabilitation phase, presence of human activity 

as well as an estimated description of the vegetation type was as well described for each RST.  

The locations of the RSTs were, like the camera trap stations, decided based on the suitability 

assessment and local expertise of the area, and were subjected to limitations such as 

accessibility by foot and/or vehicle. A total of 22 RSTs was conducted in different areas of the 

sampling site. The path followed for each RST was recorded as a track with a GPS device; all 

the recce transects are displayed in figure 5. It must be pinpointed, that the activity of machines 

due to logging and maintenance of roads might have erased some evidence of wildlife activity 

in those transects carried out at old roads.  

 

Data analysis 

 

The information obtained with the transects was organized in a data set showing, for each of 

the 22 transects, a list of mammal species present, as well as a list of the elephant signs 

encountered. The criteria for identification of mammals and their signs were based on 

recommendations and descriptions from Payne & Francis (2007) and Ancrenaz (2013) and the 

previous experience of the observers. Additionally, data from the RSTs was analysed with 

descriptive count statistics that were further used to calculate the Encounter rate (ER) and the 

Encounter effort (EE) for elephants. The ER and EE are used here as a measure of, respectively, 

the success and the effort needed in finding elephant signs while walking a transect. 

 

Total number of transects 

Number of RSTs in which each species/group was detected 

Figure 6: Sample images of indirect elephant signs. From left to right: dung, feed mark and 

footprints. 
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Survey effort (SvE): To calculate the survey effort of each RST, the total distance walked (in Km) was 

calculated. 

Total survey effort (TSvE): The total survey effort was obtained by summing the survey effort of each RST. 

Total number of independent encounters of elephant signs (per RST and in total): Encounters of elephant 

signs were considered independent from each other if the type of sign was different or the signs were separated 

at least 5m from each other. 

Encounter rate for elephants (ER) (number of elephant signs per Km walked): The raw data of elephant signs 

was weighted with the survey effort in order to obtain a relatively accurate index for elephant presence. It was 

calculated for those RSTs in which elephant presence was found and for all the survey, with the following 

formulae: 

where ‘N’ is the number of independent elephant signs encountered per RST and ‘TN’ is the total number of 

independent elephant signs encountered for the whole survey. 

Encounter effort for elephants (EE) (number of Km walked per independent encounter): Measure of the 

survey effort needed to encounter an independent elephant sign. 

 

 

2.3.5 Opportunistic observations 
 

Opportunistic data on elephant signs found while not conducting the camera trap or RSTs 

surveys, was systematically recorded following the same procedure as for the RSTs (GPS 

coordinates, type, condition, estimated date of presence, etc.) (figure 7). In addition, direct 

sightings of mammals were also noted. The information obtained in an opportunistic way, was 

organized in a data set showing a list of mammal species present as well as a list of the elephant 

objects encountered. Like for the previous survey, the type of plants consumed by the elephants 

were identified whenever feed marks were found. Furthermore, based on the amount, type and 

size of the elephant signs, an estimation of elephant group composition was as well carried out. 

To identify direct and indirect signs of animals, the methods employed for the RSTs were as 

well used for this survey.   

 

Surveys 3, 4 and 5 were intended to take place for four months (March 2017 to June 2017). 

However, due to problems with customs these surveys took place only for three months (April 

2017 to June 2017). 

Figure 7: Left: measuring an elephant footprint, which can help with estimating its size/age. 

Right: documenting a dung pile with a camera. 

ER = N / SvE  (for each RST) 

Total ER = TN / TSvE  (for the survey). 

EE = 1 / ER (for each RST) 

Total EE = 1 / TotalER (for the survey). 
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A map of elephant presence and distribution in and nearby the INIKEA project site was 

produced by gathering the information obtained with surveys 2-5. The GIS data for each 

location were elephant signs were found was analyzed with QGIS to obtain ranges of elevation, 

steepness and distance to water of elephant presence. Additional data documented from all the 

observations provided extra information regarding the possible group composition of the 

elephants, estimated time of presence at the site and use of food resources. Group composition 

was estimated based on information from the interviews (description of direct sightings), the 

pictures of the camera traps and the encountered signs. For instance, when possible, the size of 

dung boli and footprints were measured, since both have been reported to be positively related 

to age in Asian elephants (Reilly 2002, Kongrit and Siripunkaw 2017) (figure 8).  

The approximate date of elephant presence was estimated for each of the locations based on 
the information obtained with the camera traps, the interviews as well as the type and state of 
the elephant signs found (e.g. estimating dung decay stages and assessing freshness of feed 
marks) (figure 9) (Hedges & Lawson 2006, Alfred et al. 2010, Ancrenaz 2013). To obtain 
information about the elephants’ food consumption in the area, the type of plants that presented 
elephant feed marks were documented and identified as specifically as possible. In addition, 
information on crop raiding by elephants was obtained with the interviews. 

Figure 8: Comparing the size of different elephant footprints. Footprints in the left image 

clearly belong to an elephant smaller in size than the footprint of the image to the right. 

Figure 9: Elephant dung of different ages and decay stages. Left: Fresh dung attracts insects 

such as butterflies and beetles. The shape of the dung boli can be intact. Center: After a few 

days, fungi spores germinate, and mushrooms grow on dung. Right: Older and/or more 

decayed dung boli lose their original shape and consistence. 
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3. RESULTS 
 

3.1. Potential suitable elephant habitat at the INIKEA site 

 

From the total area of the INIKEA project site calculated with ArcMap (19,822 ha), 8,356 ha 

correspond to habitat that Bornean elephants have been reported to prefer based on elevation, 

steepness and water proximity. These areas identified as suitable habitat for elephants represent 

a 42.15% of the total extension of the site and are spatially illustrated in a suitability map (figure 

10). The areas displayed in this map correspond to habitats that are, at the same time, at an 

elevation of up to 400m, not further than two Km from a main river and in a terrain with a 

steepness up to 7.5 degrees. 

 

 

3.2. Medium-large terrestrial mammal species composition 

 
3.2.1 Camera trap survey 

 
A total of 7,395 pictures were obtained from 24 camera trap stations, with a total sampling 

effort of 451 camera trap days. Of these, 4,380 (59.23%) were blank pictures, 3,006 (40.65%) 

contained identifiable wildlife and 9 (0.12%) were not possible to identify. Out of the 3,006 

pictures of wildlife, 3,003 (99.9%) were mammals and three (0.1%) belonged to a bird, the 

Bornean crested fireback (Lophura ignita). Regarding the images of mammals, 11 

species/groups were represented (figure 11). The mammal most frequently photographed was 

Figure 10: Resulting map portraying suitable areas for elephants at INIKEA project site and 

their extension. 
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the bearded pig (Sus Barbatus) with 995 pictures (33.13%) from 17 stations, followed by the 

sambar deer (Rusa unicolor) with 914 pictures (30.44%) from 11 stations, muntjac (Muntiacus 

sp.) 617 pictures (20.55%) from 12 stations, southern pig-tailed macaque (Macaca nemestrina) 

197 pictures (6.56%) from 8 stations, Bornean elephant with 136 pictures (4.53%) from two 

stations, mouse deer (Tragulus sp.) with 98 pictures (3.26%) from four stations, human (Homo 

sapiens) with 23 pictures (0.77%) from two stations, long-tailed macaque (Macaca 

fascicularis) with 9 pictures (0.3%) from three stations, porcupine (Hystrix sp) with 6 pictures 

(0.2%) from two stations, sun bear (Helarctos malayanus) with 5 pictures (0.17%) from one 

station and silvered langur (Trachypithecus cristatus) with 3 pictures (0.1%) from one station.  
 

Figure 11: From left to right and up to down. Bearded pig, sambar deer, muntjac, pig-tail 

macaque, Bornean elephant, mouse deer, silvered langur and sun bear. 
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Of the 3,003 pictures of mammals obtained, 246 (8.19%) were independent captures. The 

capture rates and trapping efforts for each species/taxon for the whole survey are shown, 

respectively, in figures 12 and 13. As seen in figure 12, the most captured mammal was the 

bearded pig with a CR of 22 independent captures per 100 sampling days, followed by the 

sambar deer with a CR of 12.4. The highest trapping effort was reported for the silvered langur 

and the sun bear with 451 days of sampling needed per capture and the lowest for the bearded 

pig with a TE of 4.6 (figure 13).  

 

With regard to the capture of humans, the individual captured during the day at station 18 was 

identified as a member of the INIKEA staff. The individual captured at night at station 23, 

however, has not been identified and might be hunting illegally. 

 

Figure 12: Chart displaying the capture rate for each mammalian taxon and for all mammals. 

Figure 13: Chart displaying the trapping effort for each mammalian taxon and for all 

mammals. 
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3.2.2 RSTs 

A total survey effort of 24.8Km was accumulated from 22 RSTs. The survey effort and 

characteristics of each transect are shown in Table 1 of the Appendix (section 7.2). Along the 

22 RSTs conducted, signs (feed marks, footprints, dung, etc.) of the presence of the following 

12 mammals were found: Bornean elephant, bearded pig, sambar deer, muntjac, mouse deer, 

monkey (possibly macaques), Muller’s Bornean Gibbon (Hylobates muelleri), human, sun 

bear, squirrel (Family Sciuridae), Sunda pangolin (Manis javanica) and otter (Family 

Lutrinae). The number of RSTs in which each mammal was found is shown in figure 14.  

 

3.2.3 Opportunistic observations 

 

Evidence of the presence of the following mammals was found independently from the camera 

trap and RST surveys: Bornean elephant, sambar deer, muntjac, bearded pig, human, mouse 

deer, wild cat (Family Felidae) and gibbon. In addition, the following mammals were directly 

spotted: sambar deer, muntjac, pig-tailed macaque, silvered langur, bearded pig, human, 

squirrel and otter. 

 

 

As a result, from surveys 3, 4 and 5 a total of 16 mammal species/taxa were detected at the 

INIKEA Forest Rehabilitation project site. Of these, at least eight of them are classified under 

extinction risk by the IUCN Red List of Threatened Species 2017.3 (IUCN 2017) and two of 

them are totally protected (Schedule 1) by the law of the State of Sabah (Wildlife Conservation 

Enactment 1997). For a complete list of the mammal taxa documented in this study and their 

conservation and protection status see Table 2 in the Appendix (section 7.2). 

 

 

3.3. Bornean elephants: presence, group composition and use of the site 

 

3.3.1 Semi-structured interviews 
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From the interviews conducted to different inhabitants and workers of the INIKEA site and 

surroundings, 11 locations of elephant presence were obtained. These locations show the 

presence of elephants before the present project took place. Additionally, four more locations 

were obtained for elephants that were present in the area after data collection had started. All 

these locations are shown in a map of the INIKEA site, together with all the other locations of 

elephant presence found for the whole study and four locations were human-elephant conflicts 

have taken place (see figure 20, after section 3.3.4). Based on the interviews, at least five 

different bulls have been at the site during this survey. While two of the bulls were reported to 

be travelling alone (one of them wearing a GPS collar), two of them (one adult and one young 

male) were reported to travel together on the 18th of May until the settlement Kem Marimba, 

were they met another bull. These three latter were as well documented with the camera trap 

survey (see section 2.1.2). Regarding elephant groups, some interviewees reported the presence 

of herds in and around the INIKEA site before this survey took place. In autumn 2016 a small 

herd was in the Phase 4 area of the site, in October 2016 a herd was seen at the Gatehouse and 

around four years ago a large herd of around 30 individuals was seen near the block 19C. 

Furthermore, according to the interviewees, an elephant herd regularly passes by Luasong 

around once/twice a year. 

 

3.3.2 Camera trap survey 

 

The camera trap survey provided a total of 136 pictures and five independent captures of 

Bornean elephants at two different sampling stations: stations 8 and 15. For the whole survey, 

the CR for elephants was 1.11 captures per 100 sampling days and the TE was 90.17 sampling 

days per capture. At station number 8, 24 pictures of elephants were obtained, with just one 

independent capture (CR = 7.69; TE = 13). All these pictures show one single individual 

without tusks (figure 15), detected on the 25th of April 2017 in the evening. At station number 

15, the cameras took 112 pictures of elephants, which corresponded to four independent 

captures (CR = 11.43; TE = 8.75). The first capture took place on the 18th of May 2017 and 

52 pictures were obtained from this. The second capture took place on the 18th of May 2017 

and resulted in 28 pictures. The third capture occurred on the 20th of May 2017, resulting in 6 

pictures. Finally, the fourth capture of elephants took place on the 20th of May 2017 with 26 

pictures of elephants. All the captures took place in the evening. From all the pictures obtained 

at station 15, three different individuals were identified: one young male and two adult males 

(figures 16, 17 and 18). The three individuals were present in all the captures except for the 

third capture, were only the young adult was present. Thanks to the camera trap survey, a total 

of four individuals were identified. The first one (figure 15, possibly female) was captured 

alone; however, the sequences of pictures of the other three indicate that the two adult males 

Figure 15: Sub-adult individual without tusks photographed at Station 8. Possibly a female. 
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and the young male (figures 16, 17 and 18) were travelling together (reported as well by an 

interviewee, section 2.1.1). 

 

 

3.3.3 RSTs 

 

Evidence of elephant activity was found in 9 out of 22 RSTs, where one or more type of signs 

was reported. Encounter rates and encounter efforts of elephant signs and type of signs for each 

of the RSTs with elephant presence are shown in table 1. For this survey, a total of 40 

independent elephant signs were encountered, resulting in a total encounter rate of 1.61 

elephant signs per kilometer walked and a total encounter effort of 0.62Km per elephant sign. 

The elephant signs found with the RSTs suggest that they were left by single elephants with 

the exception of the signs found at RST number 14, which correspond to a small group (< 10 

individuals). 

 

Figure 16: Adult male photographed at station 15 with two medium-sized and quite thick tusks. 

Figure 18: Adult male with one short thick tusk photographed at station 15. 

Figure 17: Sub-adult male with two long thin tusks, smaller in size than the others. 

Photographed at station 15. 
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Table 1: In rows, transects in which evidence of elephant presence was found. In columns, type 

of signs found, number of encounters, encounter rate, encounter effort and rehabilitation phase 

of the area where the transects were conducted. 

RST Dung Footprints Feed marks Other activity Encounters ER EE Phase 

1 Yes Yes No Rub marks 3 2.17 0.46 1 

2 Yes Yes No Grass path 3 2.13 0.47 1 

3 Yes Yes Yes Grass path, mud 

marks 

9 5.56 0.18 1 

6 Yes No Yes - 2 2.06 0.49 1 

8 No No Yes - 1 0.79 1.27 1 

11 Yes No Yes - 5 4.95 0.2 2 / No phase 

14 Yes Yes No Rub marks, 

grass path 

6 5.5 0.18 4 

17 Yes Yes No - 5 5.1 0.2 Not INIKEA 

21 Yes Yes Yes - 6 4.88 0.2 2 

 

3.3.4 Opportunistic observations 

 

Indirect signs of elephant activity were found on an opportunistic basis inside and nearby the 

INIKEA site at 52 locations. These signs included dung piles, footprints, feed marks and paths 

resulting from trampled grass (figure 19). The documented signs corresponded to individuals 

of different sizes based on dung and footprint measures (ranging, respectively, 29-48cm 

diameter and 38-47cm long). Based on the quantity of signs at a same location, this survey 

Figure 19: Indirect signs of elephant activity. Left to right (upper row): path of footprints, dung 

pile and feed mark. Left to right (lower row): Elephant path and footprints on mud. 
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reports the presence of lone individuals and two small groups (one of approximately 3-5 

individuals in May and one of 2-3 individuals in June). 

 

Assembling all the information of elephant presence obtained with the different surveys, 98 

locations of elephant signs were obtained and spatially represented in the following map of 

elephant presence (figure 20). This map displays the distribution of the elephant signs found 

during data collection as well as presence reported before data collection thanks to the semi-

structured interviews. Based on GIS analyses and data from the GPS device, elephant presence 

at the INIKEA site and surroundings was found at elevations ranging from 32-483m above sea 

level, at terrains with a steepness between 0.34 and 27.47 degrees and at distances to the main 

rivers that cross INIKEA ranging from 0-8.78Km. 

 
Figure 20: Map showing the locations where elephant presence (purple stars) as well as 

human-elephant conflicts (red triangles) have been documented under this survey. 

The information gathered with all the surveys indicates the presence of male individuals 

travelling alone, small bachelor groups (2-3individuals) as well as groups of different sizes (<5 

individuals – up to 30 individuals) at the study site. Regarding the approximate date of elephant 

presence, out of the 98 locations of elephant signs, it was estimated that in 54 of them the signs 

were ‘Very recent’ (0-7days), in 19 locations the signs were ‘Recent’ (8-31days), in 11 

locations the signs were ‘Intermediate’ (1-6months), in 10 locations the signs were ‘Old’ (6-

12months) and in 4 locations the signs were ‘Very old’ (>1year). Based on the documented 

feed marks, the following plant types were consumed by elephants: gingers (Family 

Zingiberaceae), rattan climbers (Subfamily Calamoideae), wild palms (Family Arecaceae), oil 

palm (Elaeis sp), grass (Family Poaceae), bark of different trees (Ficus sp and ‘Tarap’ tree 

Artocarpus sp), lianas and banana plant (Musa sp), among others. 

 

With regard to human-elephant conflicts, the present study reported only five cases; three 

before data collection took place and two during data collection. These conflicts include: crop 

raiding of smallholders’ plantations, crop raiding of family gardens, damage of the INIKEA 

gatehouse and destruction of a planted tree in the settlement Kem Marimba of the INIKEA site.  
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4. DISCUSSION 

 

This pilot study documented the presence of 16 mammalian taxa at the INIKEA Forest 

Rehabilitation project site. Of these, at least 8 are threatened (IUCN 2017). This includes the 

Bornean elephant, whose presence was reported at 98 locations inside and nearby the INIKEA 

site and whose preferred habitat was estimated to be of 8,356 hectares, which makes 

approximately 42% of the total extension of this forest reserve.  

 

4.1. Potential suitable habitats for Bornean elephants at the INIKEA site 

 

The present project estimated the extent of preferred elephant habitat in a protected forest 

reserve strategically located between three large conservation areas in a multiple-use landscape 

in Central Sabah. Results show that approximately 8,356 ha of the INIKEA site have the 

topographical characteristics and water availability suitable for Bornean elephants; this is, 

relatively flat areas at elevations up to 400m and not further than two Km from a main river. 

The areas identified as suitable habitat for elephants extend continuously from the east side 

down to the south-centre and up until the north-western part of the site, creating a corridor that 

links the eastern and western limits of the site (figure 10). This looks promising because it 

shows that, based on elevation, steepness and water proximity, this forest reserve has the 

potential to be an elephant corridor linking the Maliau Basin and Gunung Rara Conservation 

Areas (west and north-west from INIKEA site, respectively) as well as Luasong's watershed 

(east from INIKEA site), among others.  

 

It must be remembered that for this suitability assessment it was not possible to include factors 

such as vegetation and soil types, which can influence elephants’ habitat preferences (Alfred 

et al. 2007, 2012). The dimension of suitable habitats obtained in this survey might, thus, be an 

overestimation of their actual extent. Furthermore, including the aforementioned factors in the 

assessment may also result in a reduction in the connectivity between suitable areas. There are 

other aspects that can represent changes in the estimated extension and configuration of suitable 

elephant habitat at the INIKEA site. One of them is the interval of values selected for each of 

the criteria used to determine suitability. In this case, 400m, 7.5 degrees and 2Km were used 

as thresholds for elevation, steepness and distance to a main river, respectively. However, if 

other thresholds had been chosen, the results of the assessment would have been different. 

Another aspect is the fact that using layers with more resolution (e.g. high-resolution DEM) 

and layers with detailed information for this assessment might as well have resulted in a 

different suitability map. For instance, there are areas of the INIKEA site where there are no 

main rivers, but the elephants can still have access to water (e.g. with ponds and small 

tributaries). These water bodies, nonetheless, are absent from the water layer used for the 

suitability assessment. This implies that there might be areas of suitable elephant habitat in this 

forest reserve that are not included in the resulting suitability map. The above are matters that 

should be taken into account for future research at this site, because they may affect 

management considerations.  

 

 

4.2. Medium-large terrestrial mammal species composition 
 

Thanks to the camera trap survey, Recce-survey transects as well as opportunistic observations 

16 mammalian taxa were reported. Of these mammals, at least six were documented in all the 

surveys (bearded pig, sambar deer, muntjac, mouse deer, human and Bornean elephant). 

However, others were only documented in one or two of the surveys. This discrepancy between 
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surveys can be due to the fact that, for example, whereas signs of large mammals such as deer 

and elephants are relatively easy to spot on transect surveys, finding signs of the activity of 

small-sized mammals such as porcupines and mouse deer can be challenging. This can be 

especially hard in forests were the ground is covered by leaves or in grasslands or trails with 

tall grass. Another issue is that of the habits of each group. Depending on the design of a survey, 

it might be easier to detect terrestrial animals than arboreal, or vice versa. For the present study, 

the camera traps were installed to aim terrestrial mammals of medium to large sizes and the 

RSTs focused on elephant activity. Despite of that, mammal taxa with other body sizes and 

habits were also captured on camera and detected opportunistically and while conducting 

transects. From the 16 mammal taxa identified (15 excluding humans), four of them are 

medium-large-sized and terrestrial (sambar deer, bearded pig, Bornean elephant and muntjac), 

three are medium-small-sized and terrestrial (pig-tailed macaque, porcupine and mouse deer), 

one is medium-sized and semiaquatic (otter), four are partially arboreal (long-tailed macaque, 

wild cat, sun bear and Sunda pangolin) and three are arboreal (silvered langur, Müller’s 

Bornean gibbon and squirrels) (Payne & Francis 2007, Phillipps & Phillipps 2016).  

 

The bearded pig, sambar deer and muntjac are, respectively, the top three mammals with the 

highest number of pictures, number of independent captures, CR (figure 12), number of stations 

present as well as lowest TE (figure 13). Although these measures do not inform about 

abundance, the above results indicate that the aforementioned mammals were the easiest to 

capture (i.e. had the highest trapping success and lowest trapping effort), whereas the sun bear 

and the silvered langur were the hardest to record. Regardless of not being able to estimate the 

abundances for each of the detected groups, this information can be useful for future studies, 

since it indicates the amount of sampling days that each group will require to be captured on 

camera. Nonetheless, it must be considered that for the present survey, small and/or non-

terrestrial species might have been harder to capture due to the cameras being set up to target 

medium-large sized terrestrial mammals. Therefore, it cannot be disregarded that under other 

survey designs (e.g. camera installation at lower or higher heights), number of pictures, capture 

rates, trapping efforts and number of stations present for some mammals might have been 

different than the ones obtained for this survey.  
 

With regard to the camera trap survey, the fact that 59.23% of the obtained pictures are blank 

should be noted. Blank images can be explained by different phenomena. On one hand, they 

can be a consequence of moving vegetation, insect activity, humidity or a delay between the 

trigger and the picture being taken (Ancrenaz et al. 2012). In the case of the present survey, 

most of the blank images were due to moving grass triggering one of the camera traps at station 

18. Another issue that must be mentioned is that for the first sampling period, 8 out of the 12 

cameras were installed upside-down by mistake and this may have affected the number of 

animals detected and the number of pictures obtained.  

 

Before this study took place, evidence of threatened mammals at the INIKEA site such as the 

Sunda clouded leopard (Neofelis diardi) and Bornean orang-utan (Pongo pygmaeus morio) had 

been reported by staff members. The fact that this pilot study did not detect some species that 

had been previously reported evidences the need to conduct longer wildlife inventories and 

monitoring at the site. This will allow to systematically assess the status of mammalian fauna 

at different rehabilitation phases, detect more species and provide estimates of their 

demographical characteristics. This is especially important for endangered species as well as 

for species that play an important socioeconomic role such as elephants and game species.  
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4.3. Bornean elephants: presence, group composition and use of the site 

 

A recent GPS tracking project of elephants in the Kalabakan and Gunung Rara regions showed 

that GPS locations of the collared herds were associated with rivers, small tributaries and roads 

and suggested a relation between these factors and food availability. This study reported as 

well that the tracked herds did not visit the INIKEA Forest Rehabilitation project site despite 

of this reserve having parts highly to moderately suitable for elephants (Othman et al. 2013). 

The present project is the first to document the presence of the Bornean elephant inside the 

INIKEA site and provides a preliminary map of elephant distribution in the project area (figure 

20).  

 

Evidence of the presence of elephants at the INIKEA project site and surroundings was 

registered at forest blocks of all rehabilitation phases as well as other locations such as roads 

and human settlements. Locations where elephants had been present were characterized by 

elevations ranging from 32-483m above sea level and terrains with slopes between 0.34 and 

27.47 degrees. The values for elevation were measured in the field with a GPS device and, 

although these values have some margin of error, they are quite accurate. The values for the 

steepness of the terrain, nonetheless, were obtained with the Digital Elevation Model (DEM) 

layer of the INIKEA site used for the GIS analyses. Since the DEM is a raster file, the values 

of elevation and steepness for a specific location are actually the mean values of the different 

locations contained in that pixel. In this case, the DEM has a resolution of 30m, which implies 

that there is a limitation in the accuracy of the spatial information. This spatial inaccuracy can 

be especially evident in those areas of the site where there is a high variation of topographical 

features (e.g. elevation) in a relatively short distance. Such is the case of the main road that 

crosses the INIKEA site from east to west, where almost all the elephant signs found 

opportunistically were located. Although this road is quite flat, with just a few slopes with 

moderate steepness, it is flanked by precipices in many parts. Therefore, the high values of 

steepness obtained for locations of elephant presence along the main road can be explained by 

the influence of the values of the precipices that border it. In fact, signs of elephant activity 

were only found in a steep area in one occasion, at RST14. Regarding the proximity to rivers, 

signs of elephant presence were found at distances ranging from 0-8.78Km from the main rivers 

that cross the site, with only 13 out of 98 signs being further away than 2Km from a river. 

Nevertheless, as mentioned in section 4.1, this does not mean that there were no other water 

sources nearby the signs, such as streams, that the elephants may have also had access to. 

 

Elephant presence was, therefore, mainly found at elevations, steepness and distances from 

rivers characteristic of their preferred habitat. This is partly because for the camera trap survey 

and the RSTs, sampling took place almost exclusively in areas that can potentially be preferred 

by Bornean elephants. Only the elephant signs found opportunistically were registered 

regardless of their location. It is as well important to emphasize that the fact that elephants were 

found in the above-mentioned areas does not mean that they are absent from locations with 

other topographical characteristics and specific habitat types. Due to logistic difficulties and 

limitations in the amount of equipment and manpower, it was not possible to sample the whole 

INIKEA site and its different rehabilitation phases in a representative way. In fact, sampling 

was limited to those areas that were estimated to be preferred elephant habitat and areas that 

were accessible. For instance, it was not possible to carry out RSTs in Phase 3 because those 

areas were inaccessible due to damaged roads and bridges. To study elephant activity at the 

site, ideally, all areas should have been sampled. This is because elephant movements are not 

restricted to their preferred habitats but, just like many other species, under specific 

circumstances Bornean elephants can use habitats that might be suboptimal for them. In fact, 
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these elephants have been found at elevations up to 750m and have been reported to spend 

more or less time in different vegetation types and travel longer distances (up to 9.5km/day) 

depending on the degree of human disturbances, the forests' fragmentation and the availability 

of water (Alfred et al. 2012).  

 

Results suggest that elephants are always present at the INIKEA site. However, whereas recent 

signs of single individuals were reported weekly, recent signs of elephant groups (one of 3-5 

individuals and one of 2-3) were reported in just two occasions during field work. Elephants 

organize at different social levels, with group sizes ranging typically from five to 20 

individuals. In the case of females, they organize in different social units, the most basic being 

an adult female and its dependent offspring, which can associate with other family units to 

whom they are genetically related. In contrast, elephant bulls travel alone or in small bachelor 

groups (Sukumar 2006). This suggests that the recent indirect elephant signs found between 

March-June 2017 belong to single bulls, a bachelor group of two to three individuals as well 

as a small group of three to five individuals that might have been either a family unit or a 

bachelor group. In addition, thanks to the capture of a young female at station 8 it can be 

inferred that one or more family units were present at the southern-west edge of the INIKEA 

site on the 25th of April. Unfortunately, the exact number of elephant groups and group 

members detected at the site cannot be determined, since only indirect signs were found. It is 

hard to estimate the number of elephants based on information of indirect signs such as the 

amount of dung piles because the defecation rate of Bornean elephants has not been extensively 

studied and results are inconclusive (Alfred et al. 2010). In addition, this rate might vary 

depending on the diet, which might be different in diverse vegetation types and seasons 

(Hedges & Lawson 2006). These are aspects that have not been reported yet for Bornean 

elephants. Based on the recent feed marks that were found, the elephants that visited the site 

while the present study took place fed on gingers, climbers, grasses, tree barks, lianas and 

palms. These are all plant groups that have also been reported to be part of the diet of the 

population of Bornean elephants that inhabit the Lower Kinabatangan Managed Elephant 

Range (English et al. 2014). In addition, feed marks of a single individual were as well found 

at the road that connects the INIKEA site with Luasong, which fed from some oil palms and 

banana trees of the plantations neighboring the road. 
 

Thanks to the information gathered with all the interviews, camera trap survey, RSTs and the 

opportunistic findings, it can be stated that Bornean elephants are present at the INIKEA project 

site. This includes single bulls, bachelor groups, small family units as well as larger herds. The 

distribution of the locations where elephant presence was documented suggests that the 

elephants use the main road of the site to travel from one edge to the other as well as old roads 

that are relatively easy to access. It indicates as well that the elephants roam and feed in forested 

areas of the site that are mainly flat and relatively easy to access from the main road and nearby 

the main rivers. However, as already stated, the present project represents a preliminary 

assessment of elephant presence and distribution at the INIKEA project site, and the results are 

just an indication of elephant activity at the surveyed areas. Therefore, to obtain an accurate 

map of elephant distribution in this protected forest reserve, further research is needed. 

Prospective studies should aim to sample representatively all the areas of the site, especially 

those described as suitable elephant habitat. Furthermore, there is the need to include in the 

analyses GIS layers containing detailed data about water sources, habitat types and soil types 

to obtain accurate information about the factors that affect elephant distribution in the area. 

Another aspect that can be useful to design future studies on elephant presence in this site is 

the value of capture and encounter rates as well as trapping and encounter efforts obtained with 

the camera trap and RSTs surveys. For instance, with a trapping effort of 90, forthcoming 
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research should consider that to get one capture of elephants, around 90 camera trap days of 

sampling are needed. Similarly, with an encounter rate of 1.61 (or encounter effort of 0.62), 

future research should consider that to encounter an elephant sign while doing recce walks, 

there is the need to walk approximately 620m. 

 

 

4.4. Potential of the INIKEA Forest Rehabilitation project site in wildlife management 

and conservation 

 

The present study confirmed the presence of Bornean elephants at the INIKEA project site, 

located in a multiple-use landscape in Central Sabah. Most of the forests of the Central Sabah 

Elephant Managed Range are highly degraded and elephant natural habitats are fragmented due 

the conversion of forests into oil palm and timber plantations. The connectivity between 

elephant natural habitats has been further reduced by the erection of electric fences along the 

edges of the commercial plantations. All the above has hindered the movement of elephants 

and created bottlenecks (Othman et al. 2013).   

 

The fact that the elephants are currently using the INIKEA site (a Class 1 Forest Reserve) 

suggests that this might indeed be a key area for them to connect with wildlife corridors that 

link several conservation areas and forest reserves in Central Sabah such as Maliau Basin, 

Imbak Canyon, Danum Valley, Gunung Rara and Mt. Magdelena. In addition, this protected 

site might have a crucial function as a refuge for the elephants to avoid areas highly disturbed 

by humans, such as the surrounding commercial plantations and the highway Kalabakan-Kota 

Kinabalu. Unfortunately, in the not-too-distant future the elephants are expected to lose an 

important part of their habitats in Central Sabah. This is because most of the lands that are 

planned to be turned into oil palm plantations have been described as highly suitable for 

elephants and are used by the tracked herds (Alfred et al. 2011, Othman et al. 2013). This will 

not only further reduce the elephants’ natural habitat but will as well potentially increase the 

risk of HEC in the area (Alfred et al. 2012, Othman et al 2013). Therefore, it is important for 

the elephants to have access to corridors and refuges to be able to travel around Central Sabah 

and connect with different fragmented elephant habitats. 

 

To know to which extent the elephants and other animals are using the INIKEA site and the 

ecological corridors that connect the different conservation areas of Central Sabah, further 

systematic research is needed. Identifying routes and movements of elephants and other 

endangered fauna in Central Sabah can confirm the importance of these strategic zones. If 

threatened species are indeed using these corridors, it is necessary to make sure these are strictly 

protected from deforestation and degradation. Connections between fragmented habitats can 

be critical to allow genetic flow between populations, which is of foremost importance to 

endangered species (Van Dyke 2008). In the case of Bornean elephants, it has been calculated 

that all fragmented habitat patches below 500Km2 should be connected (Alfred et al. 2012). In 

addition, these connections between elephant habitats might be part of the solution to manage 

the HEC in the area. During the present study and during the 12 previous months before it, five 

cases of HEC were reported in and around the INIKEA site. These conflicts were characterized 

by crop raiding and damage of property by, both, individuals and herds. It was confirmed that 

one of these conflicts involved a translocated bull wearing a GPS collar, which had already 

been implicated in HECs in another part of Sabah. Future studies should as well address this 

issue because the endangered Bornean elephant is not only a priority because of its uniqueness, 

but also because of its impact on humans’ lives. Tracking elephant herds can be useful to 

forecast their arrival to Luasong and the surrounding plantations, which might reduce crop 
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raiding and other potential incidents. Another issue that should be dealt with in prospective 

research is the incidence of illegal hunting in and around the INIKEA site. The camera trap 

survey conducted for this study captured an unknown man at night in one of the blocks, 

suggesting that poaching (e.g. with snares) may be happening in this protected forest reserve. 

It is important to assess this matter for the safety of the INIKEA staff and the people conducting 

research in the site as well as for conservation issues.  

 

The present study recommends as well to undertake wildlife census and long-term monitoring 

in the site in order to document the abundance and habitat use of different animal species. 

Knowing the current status of terrestrial mammalian fauna at the INIKEA site can help evaluate 

the role of this reforested and protected area on wildlife management and conservation. 

Prospective research aiming to assess the population status of different mammal species at the 

site should include as many vegetation types, rehabilitation phases and variation in 

topographical features as possible. Studies should as well evaluate the possible influence of 

proximity to human settlements and roads on mammalian distribution. Doing so will allow to 

better understand the factors that affect the presence and distribution of the mammal species 

inhabiting this forest rehabilitation site.  
 

 

5. CONCLUSIONS 

 

The present study confirms the presence of Bornean elephants and other endangered mammals 

at the INIKEA Forest Rehabilitation project site and identifies areas of the site that are suitable 

for elephants. This protected forest reserve has the potential to act as a corridor to link different 

conservation areas in Central Sabah and to be a refuge for elephants and other fauna to avoid 

surrounding areas with high human disturbance. The rehabilitation and protection of degraded 

lands can, thus, play a key role on the conservation and management of endangered species. 

This pilot project represents a starting point for developing a larger project to assess the status 

of mammal biodiversity at the INIKEA site and to help find solutions to human-elephant 

conflicts and elephant conservation in the area. It is highly recommended for prospective 

research on mammalian presence and distribution at the site to consider multiple factors such 

as vegetation types, rehabilitation phases and methods, and include a wide range of 

topographical features in the assessments. Doing so will provide more accurate results, which 

can in turn lead to better decision-making in management and conservation actions. 

 

To avoid human-wildlife conflicts and to be able to develop in a sustainable way, there is the 

need to effectively manage and protect the remaining natural habitats of Sabah as well as to 

restore those that have been degraded. This is especially important in strategically located areas 

for biodiversity conservation; such is the case of the INIKEA project site. Furthermore, future 

plans for changes in the land-use should include information on the ranging and behavioural 

patterns of different species that inhabit the area. Doing so can mitigate human-wildlife 

conflicts and help conserving biodiversity. 
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7. APPENDIX 

 

7.1 Methods 

 

7.1.1 Semi-structured interviews 

 

7.1.2 Suitability assessment 
 

Questionnaire 

- Q1. Have you seen elephant activity around the area? 

 

- Q2. When was the last time you saw and elephant or signs of elephant activity? 

 

- Q3. Where was it? 

 

- Q4. Characteristics of the observations: 

Signs (tracks, dung, feeding, other marks) 

Sightings of an individual (estimation of age and sex) 

Sightings of a group 

 

- Q5. Have you experienced any conflict between humans and elephants? Specify the type. 

Crop raiding 

Damage to constructions 

Aggressive behavior from the elephant towards humans 

Aggressive behavior from humans towards elephants 

Accident involving a vehicle 

Poaching 

 

- Q6. Have you detected any pattern on the movement or activity of the elephants? 

http://www.my.undp.org/content/malaysia/en/home/operations/projects/environment_and_energy/804%2068_forestlandscapes.html
http://www.my.undp.org/content/malaysia/en/home/operations/projects/environment_and_energy/804%2068_forestlandscapes.html
https://sabahlaw.com/Wildliferegulation.htm
http://www.wwf.org.uk/where_we_work/asia/borneo_forest/
http://www.wwf.org.my/?22905/Elephant-culling-does-not-solve-Human-Elephant-Conflict
http://www.wwf.org.my/?22905/Elephant-culling-does-not-solve-Human-Elephant-Conflict
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Procedure and Flowchart to create the suitability map: 
 

1) Obtaining of Satellite image and data layers (Input): The INIKEA polygon was obtained 

by hand-drawing it with Google Earth and was added to an ArcMap project as a new shapefile.  

Layers of water lines and altitude were downloaded from DIVA GIS (http://www.diva-gis.org/) 

and added to the ArcMap project. A basemap was obtained from ArcMap's database and added 

to the project.  

 

2) Map of the site with topographical features and water sources (Output): A map of the 

site with information of elevation and water lines was obtained by delimiting the area of interest 

(the INIKEA site's polygon) and adding the information from the vector (water lines) and raster 

(elevation) files.  
 

A map of the site with information of the steepness of the terrain (degree of slopes) was 

obtained by creating a projected elevation layer from the original elevation layer and 

calculating the distribution of slopes in degrees.  

 

3) Map of the suitable areas for elephants inside INIKEA (Output): Suitable habitats for 

elephants at the INIKEA site were determined by applying three criteria based on elephant 

habitat preference.  

 

- Topographical features: Elevation up to 400m and flat ground or gentle slopes up to 7.5 

degrees. To map the areas with an appropriate altitude for the elephants, the raster file of 

elevation was transformed into a vector file with polygons.  

To map the areas with an appropriate steepness for the elephants, a reclassification of the 

steepness categories was needed to create an attribute table with 2 classes (1: Values up to 7.5 

degrees; 2: Values higher than 7.5 degrees).  

Google Earth → Download aerial image → Create a polygon → 

Save as kmz file → Import → Conversion Tools → From KML → 

Add as layer → Data → Export data. 

 

Add Data → Add Basemap 

 

Vector file: Analysis Tools → Extract → Clip Raster file: Spatial Analyst Tools → 

Extraction → Extract by mask 

Conversion tools → From raster → Raster to polygon. Selection → Select by attributes → 

GRIDCODE ≤ 400m → Create layer from selected features 

Projections and Transformations → Raster → Project raster → UTM-Timbalai zone 50 

Spatial Analyst Tools → Surface → Slope 

Spatial Analyst Tools → Reclass → Reclassify. Conversion tools → From raster → Raster to 

polygon. Selection → Select by attributes → GRIDCODE = 1 → Create layer from selected features 
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 - Proximity to main rivers: A buffer of 2km was created at each side of the rivers and the areas 

of the buffers that fell inside the INIKEA site's limits were selected and saved.  

- Suitable areas for elephants: To map the areas that fulfil the three criteria regarding elevation, 

steepness and water availability, an intersection was run with ArcMap.  

 

4) Calculation of areas (Output): To calculate the total area of land fulfilling each criterion 

as well as the area from the resultant intersection, the files were simplified to contain less 

polygons.  

Areas were calculated with each of the files of interest (INIKEA polygon, preferred elevation, 

preferred steepness, preferred distance to water and suitable habitat).  

 

7.2 Results 
 

Table 1: Characteristics of each RST. In columns: Sampling effort in km (SE), duration in 

hours (Time), walking speed in km/h (Speed), minimum elevation in m (MinE), maximum 

elevation in m (MaxE), rehabilitation phase (Phase), presence of human activity and list of 

species detected for each of the RSTs (in rows). 

 

RST SE Time Speed MinE MaxE Phase Date 

Human 

activity Species composition 

1 1.38 1.08 1.28 129 165 1 

12/04/20

17   
Deer, pig, gibbon, squirrel, 

elephant 

2 1.41 0.98 1.44 118 186 1 

13/04/20

17   
Deer, pig, elephant, 

pangolin, otter 

3 1.62 1.05 1.54 148 184 1 

13/04/20

17 Yes 
Deer, pig, elephant, mouse 

deer, muntjac 

4 1 0.68 1.46     1 

19/04/20

17   Deer, pig. 

5 1.06 0.77 1.38 147 498 1 

20/04/20

17 Yes Deer, pig, human  

6 0.97 0.67 1.45 38 62 1 

21/04/20

17   
Elephant, pig, deer, 

monkey 

7 1.13 0.81 1.40 372 454 1 

03/05/20

17   Pig, deer, muntjac,  

8 1.27 0.87 1.46 96 154 1 

08/05/20

17   
Pig, deer, gibbon, monkey, 

elephant. 

9 1.02 0.63 1.62 100 158 2 

08/05/20

17 Yes Pig, deer, muntjac, otter. 

10 1.05 0.8 1.31 118 145 1 

17/05/20

17   Deer, pig. 

11 1.01 0.77 1.31 59 176 

None-

2 

18/05/20

17   
Deer, pig, mouse deer, 

elephant 

Analysis tools → Proximity → Buffer. Analysis Tools → Extract → Clip 

Analysis tools → Overlay → Intersect 

Data Management Tools → Generalization → Dissolve 

Open Attribute Table → Calculate geometry → Area 
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12 1.02 0.58 1.76 115 151 2 

18/05/20

17 Yes Pig, muntjac, monkey 

13 0.7 0.53 1.32 20 100 

Near 

2 

19/05/20

17   Pig, gibbon 

14 1.09 0.83 1.31 62 109 4 

19/05/20

17 Yes 
Elephant, pig, monkey, 

deer, 

15 1.09 0.83 1.31 78 139 4 

13/06/20

17   Pig, Sun Bear, monkey,  

16 1.23 0.77 1.6 84 140 1 

13/06/20

17 Yes Pig 

17 0.98 0.88 1.11 69 101 

Not 

Inikea 

14/06/20

17   
Elephant, pig, gibbon, 

deer. 

18 1.16 0.85 1.36 78 99 2 

14/06/20

17   
Pig, monkey, medium 

sized mammal with claws. 

19 1.01 0.72 1.4 163 224 1 

21/06/20

17 Yes 
Pig, deer, muntjac, 

monkey, human. 

20 1.16 0.8 1.45 99 121 4 

21/06/20

17   Deer, pig 

21 1.23 1.07 1.15 106 125 

3(or1-

2) 

22/06/20

17   
Pig, deer, gibbon, monkey, 

elephant, small carnivore,  

22 1.21 0.73 1.66 118 141 1 

22/06/20

17 Yes 
Pig, deer, mouse deer, 

wildcat, small mammal,  

TOT 24.8 17.7 1.40           

Deer, pig, muntjac, mouse 

deer, elephant, gibbon, 

monkey, pangolin, wild 

cat, Sun Bear, squirrel, 

otter, human, small 

mammal, medium sized 

mammal with claws. 

 

 

Table 2: Conservation and protection status for all the animal groups detected at the INIKEA 

site according, respectively, to the IUCN red list of Threatened Species 2017.3 (IUCN 2017) 

and the Sabah State Law (Wildlife Conservation Enactment 1997). 
 

Species/group Conservation status (IUCN red list 2017.3) Protection status (Sabah State Law) 

Borneo elephant Endangered Schedule 1 

Sun Bear Vulnerable Schedule 1 

Sunda pangolin Critically endangered Schedule 2 

Bornean gibbon Endangered Schedule 2 

Silvery langur Near threatened Schedule 2 

Pig-tailed macaque Vulnerable Schedule 2 

Long-tailed macaque Least Concern Schedule 2 

Otters Endangered-Vulnerable Schedule 2 

Wild cats Endangered-Least concern Schedule 2 

Squirrels Vulnerable-Least concern Schedule 2 

Mouse deer Least concern Schedule 3 

Muntjac Least concern Schedule 3 

Sambar deer Vulnerable Schedule 3 

Bearded pig Vulnerable Schedule 3 

Porcupine Least concern Schedule 3 

Human Least concern - 
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For a complete description of the categories of conservation and protection status of the 

mammals documented in this pilot study see, respectively, the IUCN red list Categories and 

Criteria. Version 3.1. (IUCN 2012) and the Wildlife Conservation Enactment (1997). 
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